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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using and 
configuring the EVB-LAN9252-HBI+. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to configure the EVB-LAN9252-HBI+, such as the DIGIO 
and SPI, as well as various setup options, scanning, and programming. The manual 
layout is as follows:

• Chapter 1. “Overview” – Shows a brief description of the EVB-LAN9252-HBI+ 
board quick setup.

• Chapter 2. “EVB-LAN9252-HBI+” – Provides instructions in configuring HBI and 
SPI.

• Appendix A. “Setting Up Master in Windows®” – This appendix shows how to 
set up Master in Windows.

• Appendix B. “EEPROM Programming” – This appendix shows how to program 
EEPROM.

• Appendix C. “Scanning EtherCAT Slaves” – This appendix shows how to scan 
EtherCAT Slaves.

• Appendix D. “Generating SSC Files” – This appendix shows how to generate 
SSC files.

• Appendix E. “Compiling and Programming SoC Firmware” – This appendix 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2015-2016 Microchip Technology Inc. DS50002425C-page 7
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shows how to compile and program SoC firmware.

• Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries” – This 
appendix shows how to program the PIC32 firmware using pre-built binaries.

• Appendix G. “Troubleshooting” - This appendix shows some basic trouble-
shooting tips for common problems.

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support
 2015-2016 Microchip Technology Inc. DS50002425C-page 9
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Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY
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Chapter 1.  Overview
1.1 INTRODUCTION

This document describes how to use the EVB-LAN9252-HBI+ Software Development 
Kit (SDK) as a development tool for the Microchip EVB-LAN9252 EtherCAT® Slave 
Controller.

1.1.1 Abbreviations

ADC - Analog to Digital Converter

DAC - Digital to Analog Converter

ESC - EtherCAT Slave Controller

EVB - Evaluation Board

GPIO - General Purpose Input/Output

HAL - Hardware Abstraction Layer

HBI - Host Bus Interface

IDE - Integrated Development Environment

SPI - Serial Protocol Interface

SSC - Slave Stack Code

SoC - System on a Chip

UART - Universal Asynchronous Receiver/Transmitter

Note: All the figures in the document are captured from TwinCAT 3.1.
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Chapter 2.  EVB-LAN9252-HBI+
2.1 EVB-LAN9252-HBI+ IN HBI MODE

2.1.1 EtherCAT Master and Slave Configuration

The following steps describe how to configure the LAN9252-HBI:

1. Configure the Master with the TwinCAT driver.

Refer to Appendix A. “Setting Up Master in Windows®” to configure the Twin-
CAT in Windows.

2. Download and extract EVB-LAN9252-HBI_SPI_PIC32_SDK_Vx.x.zip from 
the Microchip website (http://www.microchip.com/LAN9252-041715a).

3. In the SDK, the \ESI Files directory contains the ESI files which can be loaded 
to EVB-LAN9252-HBI+ EEPROM using TwinCAT, as displayed in Figure 2-1.

FIGURE 2-1: ESI FILES DIRECTORY 

HBI ESI files:

Note: Vx.x denotes the version number of the SDK.

ESI File name Description

Microchip 
EVB-LAN9252-HBI-INDEXED-8BIT.xml

Configures LAN9252 in HBI - Indexed 8-bit 
mode.

Microchip 
EVB-LAN9252-HBI-INDEXED-16BIT.xml

Configures LAN9252 in HBI - Indexed 16-bit 
mode.

Microchip 
EVB-LAN9252-HBI-MDP-8BIT.xml

Configures LAN9252 in HBI - Multiplexed dual 
phase 8-bit mode.

Microchip 
EVB-LAN9252-HBI-MDP-16BIT.xml 

Configures LAN9252 in HBI - Multiplexed dual 
phase 16-bit mode

Microchip 
EVB-LAN9252-HBI-MSP-16BIT.xml

Configures LAN9252 in HBI - Multiplexed sin-
gle phase 16-bit mode.

Note: Refer to Appendix D. “Generating SSC Files” to change the Vendor ID 
and slave information in the ESI files.
 2015-2016 Microchip Technology Inc. DS50002425C-page 12
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4. Copy Microchip EVB-LAN9252-HBI-MSP-16BIT.xml for this example to 
the directory path C:\TwinCAT\3.1\Config\Io\EtherCAT for TwinCAT 3.1.

5. Configure the evaluation board in HBI mode and change the switches to 16-bit 
Multiplexed single-phase mode, as mentioned in “Section 2.4 Configuration” of 
EVB-LAN9252-HBI-SPI-SQI-GPIO EtherCAT User's Guide, which can be down-
loaded from the Microchip website (http://www.microchip.com/Development-
Tools/ProductDetails.aspx?PartNO=evb-lan9252-hbi).

6. By default, the corresponding ESI file of PIC32 firmware is flashed to the deliv-
ered EVB-LAN9252-HBI+. Refer to Appendix F. “Programming PIC32 Firm-
ware Using Pre-Built Binaries”

To change the firmware in the PIC32 SoC, refer to Appendix D. “Generating 
SSC Files” and Appendix E. “Compiling and Programming SoC Firmware”.

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT.

Refer to Appendix C. “Scanning EtherCAT Slaves” for steps on scanning Eth-
erCAT slaves.

8. Program EEPROM using Microchip EVB-LAN9252-HBI-MSP-16BIT.xml.

Refer to Appendix B. “EEPROM Programming” for steps on EEPROM pro-
gramming.

Once the EEPROM has been programmed, power cycle the board without clos-
ing the TwinCAT project.

If the EEPROM programming is successful, the state will change to ‘OP’ mode 
as displayed in Figure 2-2.

Note: There can only be one microchip .xml file present in the directory path at 
a time. Please remove any .xml not being used. 

Note: The pre-built binaries are available from the Binaries directory found in 
the SDK.

Note: Please reset the board using SW2 or go to TWINCAT -> EtherCAT Devices 
->Reload Device Descriptions
 2015-2016 Microchip Technology Inc. DS50002425C-page 13
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FIGURE 2-2: OP MODE

2.1.2 HBI Demo

The following describes a demo of EVB-LAN9252-HBI+ in HBI mode:

1. Follow the steps as provided in Section 2.1.1 “EtherCAT Master and Slave 
Configuration”. Eight demo objects exist, 3 Outputs and 5 inputs, that can be 
seen on the Solution Explorer of the TwinCAT tool, as displayed in Figure 2-3.

Note: If it changes to OP mode as highlighted above, then the device is in opera-
tional state. Otherwise there is an issue with the setup.
DS50002425C-page 14  2015-2016 Microchip Technology Inc.
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FIGURE 2-3: HBI DEMO

As part of this demo, eight object variables are mapped to PIC32 pins as detailed 
in Table 2-1.

2. To change GPIO inputs, click the Inputs process data mapping option under Box 
1 in the Solution Explorer, as displayed in Figure 2-3.

The TwinCAT project window displays.

3. There are 5 different inputs that can be observed in Figure 2-4:

- Potentiometer can be adjusted on the board (ADC Pot1: See Figure 2-7).

- Temperature Senor output can be used to calculate ambient temperature. 
Refer to Section 2.3.1 “Calculating Temperature” for more information.

- UART Read Dword will display the information seen on RX from J24 RS232 
connector. It will be a decimal number reflecting 4 characters. Refer to 
Section 2.3.2 “UART Decimal to ASCII Conversion” for information on 
converting this decimal number into hex and eventually ASCII. 

- DAC Input will display the input data going into the PIC. Refer to 
Section 2.3.3 “DAC Calculations” for how this number is obtained.

- Push Button (SW50: See Figure 2-7) will be 1 when not pressed and 0 when 
pressed.

TABLE 2-1: OBJECT VARIABLE MAPPING

Variable PIC32 GPIO

Potentiometer (Input) PIC32 RB1

Temperature Sensor (Input) PIC32 RB0

UART Read Dword (Input) PIC32 RF2

DAC Input (Input) PIC32 AETXEN and PIC32 AETXCLK

Push Button (Input) PIC32 RD3

DAC (Output) PIC32 RB2

UART Write Dword (Output) PIC32 RF8

LED_D24 (Output) PIC32 RD2
 2015-2016 Microchip Technology Inc. DS50002425C-page 15
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FIGURE 2-4: INPUT VALUES

4. To view GPIO outputs, click Outputs process data mapping under Box 1 in the 
Solution Explorer, as displayed in Figure 2-3.

5. There are 3 different outputs that can be observed in Figure 2-5:

- DAC is a value that can be set and will adjust the DAC output voltage as well 
as the ADC output. Refer to Section 2.3.3 “DAC Calculations” for more 
information.

- UART Write Dword will output the value entered through TX on J24 RS232 
connector in a repeated fashion.

- LED_D24 can be set as high or low as can be seen in Figure 2-6 and on the 
board in Figure 2-7.

FIGURE 2-5: OUTPUT VALUES

FIGURE 2-6: GPIO_INPUTS VARIABLE
DS50002425C-page 16  2015-2016 Microchip Technology Inc.
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FIGURE 2-7: FEATURES ON HBI+ BOARD

2.2 EVB-LAN9252-HBI+ IN SPI MODE

2.2.1 EtherCAT Master and Slave Configuration

1. Configure the Master with the TwinCAT driver.

Refer to Appendix A. “Setting Up Master in Windows®” to configure the Twin-
CAT in Windows.

2. Download and extract EVB-LAN9252-HBI_PIC32_SDK_Vx.x.zip from the 
Microchip website (http://www.microchip.com/LAN9252-041715a).

3. In SDK, the \ESI Files directory contains the ESI files which can be loaded to 
EVB-LAN9252-HBI+ EEPROM using TwinCAT, as displayed in Figure 2-8.

FIGURE 2-8: ESI FILES DIRECTORY 

SPI ESI files:

4. Copy Microchip EVB-LAN9252-HBI-SPI_MODE.xml to the directory path 
C:\TwinCAT\3.1\Config\Io\EtherCAT for TwinCAT 3.1.

Note: Vx.x denotes the version number of the SDK.

ESI File name Description

Microchip 
EVB-LAN9252-HBI-SPI_MODE.xml

Configures LAN9252 in SPI with GPIO - 2-port 
mode.

Note: Refer to Appendix D. “Generating SSC Files” to change the Vendor ID 
and slave information in the ESI files.

Note: There can only be one microchip .xml file present in the directory path at 
a time. Please remove any .xml not being used. 
 2015-2016 Microchip Technology Inc. DS50002425C-page 17
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5. Configure the evaluation board in SPI mode as mentioned in “Section 2.4 Con-
figuration” of EVB-LAN9252-HBI-SPI-SQI-GPIO EtherCAT User's Guide, which 
can be downloaded from the Microchip website (http://www.micro-
chip.com/DevelopmentTools/ProductDetails.aspx?PartNO=evb-lan9252-hbi).

6. By default, the corresponding ESI file of PIC32 firmware is flashed to the deliv-
ered EVB-LAN9252-HBI+. Refer to Appendix F. “Programming PIC32 Firm-
ware Using Pre-Built Binaries”

To change the firmware in PIC32 SoC, refer to Appendix D. “Generating SSC 
Files” and Appendix E. “Compiling and Programming SoC Firmware”..

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT.

Refer to Appendix C. “Scanning EtherCAT Slaves” for steps on scanning Eth-
erCAT slaves.

8. Program Microchip EVB-LAN9252-HBI-SPI_MODE.xml ESI file to 
EEPROM using TwinCAT.

Once the EEPROM has been programmed, power cycle the board without clos-
ing the TwinCAT project.

If the EEPROM programming is successful, state will change to ‘OP’ mode as 
displayed in Figure 2-9.

FIGURE 2-9: OP MODE

Note: The pre-built binaries are available from the Binaries directory. This step 
can be skipped if pre-built binary is used for programming.

Note: If it changes to OP mode as highlighted above, then the device is in opera-
tional state. Otherwise there is an issue with the setup.
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2.2.2 SPI Demo

The following describes a demo of EVB-LAN9252-HBI+ in SPI mode:

1. Follow the steps as provided in Section 2.2.1 “EtherCAT Master and Slave 
Configuration”. Nine demo objects, 4 outputs and 5 inputs, can be seen on the 
Solution Explorer of the TwinCAT tool, as displayed in Figure 2-10.

FIGURE 2-10: SPI DEMO

2. As part of this demo, nine object variables are mapped to LAN9252 GPIOs as in 
Table 2-2.

3. To change GPIO inputs, click the Inputs process data mapping option under Box 
1 in the Solution Explorer, as displayed in Figure 2-10.

The TwinCAT project window displays.

4. There are 5 different inputs that can be observed in Figure 2-11:

- Potentiometer can be adjusted on the board (ADC Pot1: See Figure 2-7).

- Temperature Senor output can be used to calculate ambient temperature. 
Refer to Section 2.3.1 “Calculating Temperature” for more information.

- UART Read Dword will display information seen on RX from J24 RS232 con-
nector. It will be a decimal number reflecting 4 characters. Refer to 
Section 2.3.2 “UART Decimal to ASCII Conversion” for information on 

TABLE 2-2: OBJECT VARIABLE MAPPING

Variable LAN/PIC32 GPIOs

Potentiometer (Input) PIC32 RB1

Temperature Sensor (Input) PIC32 RB0

UART Read Dword (Input) PIC32 RF2

DAC Input (Input) PIC32 AETXEN and PIC32 AETXCLK

Push Button (Input) PIC32 RD3

DAC (Output) PIC32 RB2

UART Write Dword (Output) PIC32 RF8

LAN9252 GPIO LEDs (Output) LAN9252 GPO0-15

LED_D24 (Output) PIC32 RD2
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converting this decimal number into hex and eventually ASCII. 

- DAC Input will display the input data going into the PIC. Refer to 
Section 2.3.3 “DAC Calculations” for how this number is obtained.

- Push Button (SW50: See Figure 2-7) will be 1 when not pressed and 0 when 
pressed.

FIGURE 2-11: INPUTS IN SPI MODE

5. To view GPIO outputs, click Outputs process data mapping under Box 1 in the 
Solution Explorer, as displayed in Figure 2-10.

6. There are 4 different outputs that can be observed in Figure 2-12:

- DAC is a value that can be set and will adjust the DAC output voltage as well 
as the ADC output. Refer to Section 2.3.2 “UART Decimal to ASCII Con-
version” for information on how to calculate this.

- UART Write Dword will output the value entered through TX on J24 RS232 
connector in a repeated fashion.

- LAN9252 GPIO LEDs can be turned on and off by clicking on LAN9252 GPIO 
LEDs under the Outputs process data mapping. An example on how to do this 
and what it looks like on the board can be seen in Figure 2-13 and 
Figure 2-14 respectively.

- LED_D24 (See Figure 2-7) can be set as high or low for on or off respectively.

FIGURE 2-12: OUTPUTS IN SPI MODE

FIGURE 2-13: SETTING LAN9252 GPIO OUTPUTS
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FIGURE 2-14: MODIFIED GPIOS ON THE BOARD

2.3 EVB-LAN9252-HBI+ CALCULATIONS

2.3.1 Calculating Temperature

The Vout of the temperature sensor is connected to the ADC. The output of the ADC 
(ADCout) will be the value displayed in the EtherCAT application and be named Tem-
perature Sensor. To get the output voltage (Vout) see Equation 2-1

EQUATION 2-1: TEMP SENSOR VOUT

Now use Vout and calculate the temperature in degrees Celsius (Equation 2-2):

EQUATION 2-2: TEMPERATURE

EXAMPLE 2-1: ETHERCAT APPLICATION OUTPUTS 235 (ADCOUT=235).

Vout
ADCout 3300mV

1023mV
-------------------------------------------------- 
 =

Temp C  Vout 500mV–

10
mV
C
---------

-------------------------------------

 
 
 
 

=

Vout
235 3300mV 

1023mV
----------------------------------------- 758.06mV

Temp C  758.06mV 500mV– 

10
mV
C
---------

------------------------------------------------------- 25.8C

= =

= =
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2.3.2 UART Decimal to ASCII Conversion

The EtherCAT application will display the UART input as decimal. This decimal number 
represents 4 different characters. Example 2-2 details how to convert from a decimal 
number to hex and then ASCII. The characters entered in order were a, A, 1, !.

EXAMPLE 2-2: DECIMAL TO HEX TO ASCII

2.3.3 DAC Calculations

Depending on the value entered into the DAC Output, a calculated voltage will be pres-
ent on the DAC output. This voltage is then sent to the ADC on the PIC and this number 
is displayed on the DAC input. An example can be found in Example 2-3 below. The 
first equation needed is the calculation of the output voltage of the DAC (Equation 2-3).

EQUATION 2-3: DAC OUT

After calculating the DAC output voltage, it is possible to determine the value produced 
from the ADC (Equation 2-4).

EQUATION 2-4: ADC OUT

EXAMPLE 2-3: A VALUE OF 1250 IS ENTERED INTO THE DAC OUTPUT.

Decimal 556876129
Hex 0x21314161

ASCII 21 !
ASCII 31 1
ASCII 41 A
ASCII 61 a

=
=

= =
= =
= =
= =

DACout
3300mV DAC 

# of Resistors in Ladder
---------------------------------------------------------

# of Resistors in Ladder will always be 4096 for this board

=

ADCout
DACout 1023 

3300
---------------------------------------------

1023 is the MAX ADC according to the ADC Transfer Function

=

DACout
3300mV 1250mV 

4096
------------------------------------------------------ 1007mV

ADCout
1007mV 1023 

3300mV
-------------------------------------------- 312

= =

= =
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Appendix A. Setting Up Master in Windows®
A.1 INTRODUCTION

This appendix details how to setup a Master in Windows®.

Download and install TwinCAT on Windows from http://beckhoff.com.

A.1.1 TwinCAT Ethernet Driver - Installation

To install the TwinCAT Ethernet Driver:

1. If TwinCAT installed successfully, a TwinCAT icon will display in the bottom-right corner of the desk-
top. Click the TwinCAT icon.

A pop-up menu displays.

2. Select TwinCAT XAE (VS XXXX), as displayed in Figure A-1.

FIGURE A-1: SYSTEM MANAGER

3. Go to TWINCAT>Show Real Time Ethernet Compatible Devices… as in Figure A-2.

Note: VS XXXX refers to the version of Visual Studio installed on the computer.
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FIGURE A-2: SHOW REAL TIME ETHERNET COMPATIBLE DEVICES

4. Select the network adapter and install the TwinCAT driver as in Figure A-3.

FIGURE A-3: ETHERNET ADAPTERS DIALOG
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Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master. 
The network adapter will then be moved to “Installed and ready to use devices” as displayed in 
Figure A-4.

FIGURE A-4: INSTALLED AND READY TO USE DEVICES

5. Go to the corresponding network adapter properties and then select TwinCAT drivers as displayed in 
Figure A-5 and Figure A-6. To access network adapter properties as seen in the figures below go to 
Control Panel\Network and Internet\Network Connections.
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FIGURE A-5: NETWORK ADAPTER PROPERTIES MENU

FIGURE A-6: LOCAL AREA CONNECTION PROPERTIES

Note 1: Only select TwinCAT drivers.

2: If TwinCAT cannot find the EtherCAT slaves after following the steps in Appendix 
C. “Scanning EtherCAT Slaves”, restart the computer and attempt to scan again.
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Appendix B. EEPROM Programming
B.1 INTRODUCTION

This appendix shows how to program EEPROM.

B.1.1 EEPROM Programming

To program EEPROM:

1. After a successful scan, click the arrow next to “Device 2 (EtherCAT)” on the Solution Explorer in the 
TwinCAT tool, as displayed in Figure B-1.

FIGURE B-1: DEVICE 2 (ETHERCAT)

2. Click the Online tab in the TwinCAT project window.

3. Right-click the LAN9252 listing and select EEPROM Update from the contextual menu, as displayed 
in Figure B-2.
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FIGURE B-2: EEPROM UPDATE

The Write EEPROM window displays.

4. Select the corresponding EEPROM configuration and then click OK to initiate EEPROM program-
ming.

For example, Figure B-3 shows LAN9252 one of DIGIO configuration is selected for EEPROM pro-
gramming in TwinCAT.

Note: The xml file that is to be programmed MUST be copied into “C:\TwinCAT\3.1\Config\Io\EtherCAT
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FIGURE B-3: WRITE EEPROM DIALOG
 2015-2016 Microchip Technology Inc. DS50002425C-page 29



EVB-LAN9252-HBI+
QUICK START
GUIDE

Appendix C. Scanning EtherCAT Slaves
C.1 INTRODUCTION

This appendix shows how to scan EtherCAT Slaves.

C.1.1 Scanning EtherCAT Slaves

To scan EtherCAT slaves:

1. Connect Port 0 of the device to the master using RJ45 Ethernet cable, and then power up the board.

The Link/Act LED should be ON at Port 0 when the cable is present. If the Link/Act LED is not ON, it 
indicates there is an issue with the connection or cable.

2. If any devices are present, delete them accordingly by right-clicking the device and selecting Remove, 
as displayed in Figure C-1.

FIGURE C-1: REMOVE DEVICE

3. Scan for EtherCAT slave devices by right-clicking Devices under I/O and then selecting Scan, as dis-
played in Figure C-2.
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FIGURE C-2: SCAN DEVICES MENU

4. Click OK to continue scanning as in Figure C-3.

FIGURE C-3: DEVICE DIALOG

If the check box is not checked as displayed in Figure C-4, then either the device is not functional or 
the driver is not installed properly.
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FIGURE C-4: DEVICE DIALOG, UNCHECKED

5. Click Yes as displayed in Figure C-5 to scan for boxes.

FIGURE C-5: CONFIRMATION DIALOG

6. Click Yes as displayed in Figure C-6 to allow free run.

FIGURE C-6: CONFIRMATION DIALOG 2
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7. The device list is displayed as seen in Figure C-7.

FIGURE C-7: DEVICE LIST

8. After a successful scan, there will be activity on Link/Act LED at Port 0 (It will blink rapidly).
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Appendix D. Generating SSC Files
D.1 INTRODUCTION

This appendix details how to generate SSC files. These files can be found here: 
http://www.microchip.com/SWLibraryWeb/producttc.aspx?product=LAN9252%20EtherCAT%20SDK

D.1.1 Generating SSC Files

To generate SSC files:

1. Start the SSC Tool from the Windows Start menu, as displayed in Figure D-1.

FIGURE D-1: SSC TOOL

2. From the menu bar, click File>New as displayed in Figure D-2.

FIGURE D-2: NEW ETHERCAT SLAVE

3. Click Import to import the SSC Tool configuration file Microchip 
EVB-LAN9252-HBI-SPI-SSC-CONFIG.xml from the directory {SDK_INSTALL_-
PATH}/EVB-LAN9252_SDK_VX.X/SSC/ as displayed in Figure D-3.
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FIGURE D-3: IMPORT PROJECT

After selecting the file, click Open to import the SSC Tool configuration file.

4. Once imported, check the “Custom” drop-down box, select the “Microchip-EVB-LAN9252-HBI” con-
figuration, and then click OK, as displayed in Figure D-4.

FIGURE D-4: CUSTOM SSC FILE SELECTED

5. All listed parameters under the Slave Information tab can be changed, as displayed in Figure D-5.

Note: By default, SDK ESI files have an object configuration with Microchip Vendor ID.
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FIGURE D-5: SLAVE SETTINGS

6. Click Tool>Application>Import from the menu bar, as displayed in Figure D-6.

FIGURE D-6: IMPORT MENU

7. Select the file pic32_mchp_gpio_sample_app.xlsx which can be found in the directory 
{SDK_INSTALL_PATH}/EVB-LAN9252_SDK_VX.X/HBI Application/ or {SDK_INSTALL_-
PATH}/EVB-LAN9252_SDK_VX.X/SPI Application/ depending on the mode the board is con-
figured for.

pic32_mchp_gpio_sample_app.xlsx is an object file which contains the information about appli-
cation objects.

A status message displays as in Figure D-7.
DS50002425C-page 36  2015-2016 Microchip Technology Inc.



Generating SSC Files
FIGURE D-7: STATUS MESSAGE

8. Click OK to continue.

9. From the menu bar, click Project>Create New Slave Files.

The Create new Slave Files window displays, as in Figure D-8.
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FIGURE D-8: CREATE NEW SLAVE FILES

10. Click the Windows Start button to create a new project file, Src folder, and ESI file (Slave Information 
file) in the desired directory path.

A pop-up window will indicate that the files have been successfully created.

11. Click OK to continue.

Along with generated new slave files, an ESI file (.xml file) also will be generated. This ESI file will 
have information about new Vendor ID and object configuration. Program this ESI file into EEPROM 
as mentioned in Appendix B. “EEPROM Programming”.

12. Replace generated application files with SDK application files as displayed in Figure D-9. 

SDK Application files can be found the either the HBI Application or SPI Application and then Sample 
Application Files depending on the board configuration.

Note: The above values signify the following:

- $PROJECT_FILE_PATH - The location where the SSC project file is saved.

- $SRC_FILE_PATH - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its 
corresponding Change button.

- $ESI_FILE_PATH - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its 
corresponding Change button.
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FIGURE D-9: SDK APPLICATION FILES

FIGURE D-10: APPLICATION FILES

13. Browse to the directory where the new files were created, as shown in the example:

- Src (Folder): This folder contains the Beckhoff Slave Stack code.

- Microchip PIC32 Slaves (ESP): This is the SSC Tool project file.

- Microchip PIC32 Slaves (XML): This is the EtherCAT slave information file that must be 
used as an input to the EtherCAT master tool to configure EtherCAT slave controllers.

14. Copy all the files inside the Src folder to the following directory:
{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SDK_VX.X/SSC/Common

D.1.1.1 WHY REPLACE IS REQUIRED

Generated application files will not have the code for accessing the GPIO lines. GPIO support is provided 
in delivered SDK application files. Hence, the replace is required to get the demo application.

Note: Application files would be named as pic32_mchp_gpio_sample_app as in Figure D-10. This 
is because in this demo, input object file is given as pic32_mchp_gpio_sample_app.xlsx.
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Appendix E. Compiling and Programming SoC Firmware
E.1 INTRODUCTION

This appendix details how to compile and program SoC firmware.

E.1.1 Compiling and Programming SoC Firmware

To compile and program SoC firmware:

1. Open the MPLAB IDE and import the SSC project.

The MPLAB project file is located under {SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SD-
K_VX.X/SSC/.

2. Compile the source code as displayed in Figure E-1.

FIGURE E-1: SOURCE CODE

If the compilation is successful, the output window will display “BUILD SUCCESSFUL” as shown in 
Figure E-2.

FIGURE E-2: BUILD SUCCESSFUL

3. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s 
JTAG pins.

4. To program the PIC32 SoC, click the Make and Program Device Main Project button, as displayed 
in Figure E-3.

Note: This demo project is debugged with the PICkit-3 In-Circuit debugger/programmer.
 2015-2016 Microchip Technology Inc. DS50002425C-page 40



Compiling and Programming SoC Firmware
FIGURE E-3: MAKE AND PROGRAM DEVICE MAIN PROJECT BUTTON

5. To debug the PIC32 SoC, click the Debug Main Project button, as displayed in Figure E-4.

FIGURE E-4: DEBUG MAIN PROJECT BUTTON
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Appendix F. Programming PIC32 Firmware Using Pre-Built 
Binaries
F.1 INTRODUCTION

This appendix shows how to program PIC32 firmware.

F.1.1 Programming PIC32 Firmware Using Pre-Built Binaries

To program the PIC32 firmware using pre-built binaries:

1. Download and install MPLAB IPE V X.X from the following link:

http://microchip.wikidot.com/ipe:installation

2. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s 
JTAG pins.

3. Open the MPLAB IPE.

The window displays as in Figure F-1.

Note: x.xx denotes the version number of the MPLAB IPE.
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FIGURE F-1: MPLAB IPE

4. Select the corresponding device from the “Device” drop-down box and then click Apply.

5. Select the debugger/programmer from the “Tool” drop-down box and then click Connect.

6. From “Source,” click the Browse button and select the hex files which can be found in the “Binaries” 
directory of EVB-LAN9252-HBI_PIC32_SDK V X.X.

7. Once the hex files are loaded, click Program.
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Appendix G. Troubleshooting
G.1 INTRODUCTION

This appendix details how to troubleshoot some issues that may occur when using the EVB-LAN9252-HBI+. 
If the issue cannot be resolved using this troubleshooting appendix, please use the Microchip website to 
request further assistance.

G.1.1 Cannot Program PIC32

If the situation arises where the PIC32 will not program, ensure the proper header is being used.

DO NOT USE J14 to Program the PIC32.

DO USE J13 to program the PIC32. Align PIN1 of the programming device with PIN1 of the header as 
labeled on the board.

G.1.2 Error when board requests PREOP

If an error similar to that seen in Figure G-1 occurs, it could be the result of two possible issues:

FIGURE G-1: PREOP FAILURE

1. The board is not configured correctly to use the desired mode. Please refer back to 
Section 2.1.1 “EtherCAT Master and Slave Configuration” for information on the proper configu-
ration of the board for HBI mode and Section 2.2.1 “EtherCAT Master and Slave Configuration” 
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for information on the proper configuration of the board for SPI mode.

2. After programming the board’s EEPROM, one must follow the following steps:

1: Remove the device as seen in Figure G-2

2: Power cycle the board

3: Rescan for devices

FIGURE G-2: REMOVING A DEVICE

G.1.3 Values Do not Update in Application

If this issues occurs, please power cycle or reset the board and try changing the output value again. If the 
input values do not update please also power cycle or reset the board.
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